Environmental Assessment Writing Template
GUIDANCE:
This writing template has been set up to assist with creating a document that is compliant with the Americans with Disabilities Act (ADA). Guidance for what content should be included can be found in the appropriate Environmental Document Annotated Outline (AO) located on the SER Forms and Templates page. For assistive technology users, form fields have been used to alert you to where text needs to be inserted. Should you need further accessibility assistance, please contact env.webmaster@dot.ca.gov.
Documents that will be converted to PDF and posted on the Caltrans internet must pass the PDF Accessibility Checker 3 (PAC 3). This template has been formatted to assist with final PAC 3 compliance. As you use this template, it is recommended to follow the instructions listed below to ensure the document remains accessible.
· Font:
· Text should be no smaller than 12-point (10-point is approved for use in tables and footnotes) and should be either Arial, Verdana, Tahoma, Calibri, or Century Gothic. This template uses a 12-point Arial default font.
· When copying text from another source, use the “Keep Text Only” paste option.
· Color alone should not be used to convey meaning.
· Use paragraph spacing between paragraphs, not hard returns.
· Tables:
· To add a title (caption), highlight table, right click, and choose “Insert Caption.” Add title to caption box, label as table and choose “Above selected item” for position. Click on “Numbering” for additional formatting—including the chapter number is recommended in the body of the document. In other sections of the document (i.e., summary, appendices, etc.), including the chapter number is not recommended as the chapter numbering is based on the main body headings. However, a new label (e.g., Appendix A Table -) can be created in the caption box. That label will then appear in the dropdown list and can be reused. Follow the same instructions for inserting a caption on additional tables (copying and pasting is not recommended). Once inserted, additional formatting can be applied to the caption. By using this feature, tables will auto number and will also appear in the lists of tables when the lists are updated.
· Keep tables simple (i.e., no merged or split cells) to avoid reading order issues.
· Add a table summary. Highlight table, right click, go to “Table Properties,” then click on the “Alt Text” tab. Enter a title and brief description. This will help avoid errors in PAC 3.
· Define header rows. Highlight the header row, right click, go to “Table Properties,” and select the box for “Repeat as header row at the top of each page.” Also check the Table Design tab and make sure “Header Row” is checked in “Table Style Options.” This will bring up table styles with header row formatting that can be applied if desired.
· If possible, keep tables on the same page, rather than splitting onto a second page, this will also help avoid a PAC 3 error.
· If a table cannot fit on one page, don’t allow individual rows to break across the page. Highlight table, right click, go to “Table Properties,” and make sure the box for “Allow row to break across pages” is unchecked.
· Figures/Images:
· To insert an image, first insert a normal paragraph mark where the figure will be located. Then click on “Pictures” in the “Insert” tab. Choose “This Device,” then locate appropriate picture file. JPEGs are the recommend file type. Following this method will result in less errors than copying and pasting an image. 
· To add a title (caption), follow instructions shown above in table section and label as figure in the caption box.
· Add alt text. Figures or other images (e.g., the Caltrans logo) that cannot be read by a screen reader need to contain alternative text or marked as decorative. Right click on the item and choose “Edit Alt Text” to add description or mark as decorative.
· Links:
· Add alt text. Highlight link, right click, go to “Edit Hyperlink,” then choose “ScreenTip” in the upper right-hand corner. Add text that briefly describes the destination, function, and/or purpose.
In addition, please note the following:
· The use of this writing template is not mandatory, it is provided as a work aid to assist you in creating an accessible document.
· Only use those sections which are applicable to your document. NOTE: the regulatory setting is optional. If included, use the language provided in the AO without edits.
· When a section is deleted, the numbering will automatically update.
· There are a few areas where guidance or special notes have been provided, these are called out with blue font and the terms “GUIDANCE” or “NOTE.” Make sure to delete these instructions before publishing.
· Insert document name into the footer.
· To jump to desired sections, use the navigation pane shown on the left of the screen. If the navigation pane is not visible, it can be turned on by marking the “Navigation Pane” box located under the “View” tab in the “Ribbon” at the top of the screen.
· Text boxes should not be used as they can cause issues with screen readers. Borders can be used to give the look of a text box.
Final Steps
· Update document title. Go to “File” in the Ribbon, click on “Info.” In the properties section, edit the title (i.e., remove the writing template title and enter project title).
· Once all edits are complete and the table of contents (TOC) has been updated, highlight the entire table, click “Ctrl+Shift+F9.” This will deactivate the links in the TOC. This is to remove the link errors that will occur in PAC 3. Users will still be able to navigate through the Word document via the Navigation Pane or through Bookmarks in the PDF file. NOTE: Once the links have been deactivated, the TOC can no longer be updated. If updates are necessary (e.g., between draft and final documents), a new TOC will need to be inserted. Repeat process to also deactivate the links in the List of Tables and List of Figures.
· When the document is finished and ready to be converted to a PDF, click on “Create PDF” in the “Acrobat” tab. There are other methods of saving as a PDF, but some may result in more PAC 3 errors. It is also recommended to use the latest 64-bit version of Adobe Acrobat Pro if possible.


COVER SHEET GUIDANCE:
· Modify the text on this page as appropriate for the project.
· Insert project photo if desired, add alt text or mark as decorative.
· Do not alter MOU statement at bottom of page.
[bookmark: Text10]Insert Project Name
[bookmark: Text11]COUNTY, CALIFORNIA
[bookmark: Text12][bookmark: Text13][bookmark: Text14][bookmark: Text15]DISTRICT DISTRICT NUMBER –COUNTY ABBREVIATION–ROUTE (PM POSTMILES)
[bookmark: Text16]EA/EFIS/FEDERAL AID NUMBER
[bookmark: Text6]Environmental Assessment and enter Draft or Final Section 4(f) Evaluation [NOTE: only include if there is an Individual or Programmatic Section 4(f) Evaluation] with Finding of No Significant Impact [NOTE: only add for “Final” EA]
[GUIDANCE: INSERT A PHOTO HERE]
Prepared by the
State of California, Department of Transportation
and enter (Local Agency) if applicable
The environmental review, consultation, and any other actions required by applicable Federal environmental laws for this project are being, or have been, carried out by Caltrans pursuant to 23 USC 327 and the Memorandum of Understanding dated May 27, 2022, and executed by FHWA and Caltrans.
[image: ]
[bookmark: Text8]Insert date (month and year)
[bookmark: _Toc117166475][bookmark: _Toc126070447][bookmark: _Hlk66973053]General Information about This Document
[bookmark: _Hlk117159848]GUIDANCE: Use this page for DRAFT documents. Modify the text as needed for your document. See the AO for additional instructions.
What’s in this document:
[bookmark: Text67]The California Department of Transportation (Caltrans), as assigned by the Federal Highway Administration (FHWA), has prepared this Environmental Assessment (EA), which examines the potential environmental impacts of the alternatives being considered for the proposed project located in enter project location. Caltrans is the lead agency under the National Environmental Policy Act (NEPA). The document tells you why the project is being proposed, what alternatives have been considered for the project, how the existing environment could be affected by the project, the potential impacts of each of the alternatives, and the proposed avoidance, minimization, and/or mitigation measures.
What you should do:
· Please read this document.
· [bookmark: _Hlk115257299][bookmark: Text2][bookmark: _Hlk61527083][bookmark: Text3]Additional copies of this document and the related technical studies are available for review at enter Caltrans district office or local agency office as appropriate, and/or public institution, such as a library, community center, school, etc., where the document can be viewed and provide addresses and operating hours for all locations. This document may be downloaded at the following website: enter web page address.
· [bookmark: _Hlk61527366][bookmark: Text4]NOTE: Include as applicable: Attend the public hearing. Enter date and location of hearing if known.
· [bookmark: _Hlk61527414][bookmark: Text78]We’d like to hear what you think. If you have any comments about the proposed project, please attend the enter type of meeting [NOTE: For State Highway System projects, see Chapter 11, Article 7 of the PDPM for guidance. Local Assistance projects should refer to the LAPM, Chapter 8, Public Hearings] and/or send your written comments via postal mail or email to enter Caltrans or (Local Agency) by the deadline.
· [bookmark: Text30]Send comments via postal mail to:
Enter contact name and address
· [bookmark: Text31]Send comments via email to: Enter email.
· [bookmark: Text32]Be sure to send comments by the deadline: Enter due date.
What happens next:
[bookmark: Text79][bookmark: Text75]After comments are received from the public and reviewing agencies, Caltrans, as assigned by the FHWA, enter "and in cooperation with (Local Agency)" as appropriate may: (1) give environmental approval to the proposed project, (2) do additional environmental studies, or (3) abandon the project. If the project is given environmental approval and funding is obtained, Caltrans enter "and/or" (Local Agency) if applicable could design and construct all or part of the project.
Alternative Formats:
[bookmark: Text80][bookmark: Text33][bookmark: Text34]GUIDANCE: Update the following to reflect what alternative formats will be made available and update contact information as needed. For individuals with sensory disabilities, this document can be made available in Braille, in large print, on audiocassette, or on computer disk. To obtain a copy in one of these alternate formats, please call or write to enter Caltrans or (Local Agency), Attn: Enter contact name and address; enter phone number (Voice), or use the California Relay Service 1 (800) 735-2929 (TTY to Voice), 1 (800) 735-2922 (Voice to TTY), 1 (800) 855-3000 (Spanish TTY to Voice and Voice to TTY), 1-800-854-7784 (Spanish and English Speech-to-Speech) or 711.


[bookmark: _Toc117166476][bookmark: _Toc126070448]General Information about This Document
GUIDANCE: Use this page for FINAL documents. Modify the text as needed for your document. See the AO for additional instructions.
[bookmark: _Hlk61529577][bookmark: _Hlk61529618][bookmark: Text68]The California Department of Transportation (Caltrans), as assigned by the Federal Highway Administration (FHWA), has prepared this Environmental Assessment with Finding of No Significant Impact for the proposed project located in enter project location. Caltrans is the lead agency under the National Environmental Policy Act (NEPA). The document tells you why the project is being proposed, what alternatives have been considered for the project, how the existing environment could be affected by the project, the potential impacts of each of the alternatives, and the proposed avoidance, minimization, and/or mitigation measures. The Environmental Assessment circulated to the public for enter number days between enter date and enter date. Comments received during this period are included in enter appropriate chapter or appendix. Changes to the document made since the draft document circulation are shown enter description of how changes are shown. Minor editorial changes and clarifications are not shown. Additional copies of this document and the related technical studies are available for review at enter Caltrans district office or local agency office as appropriate, and/or public institution, such as a library, community center, school, etc., where the document can be viewed and provide addresses and operating hours for all locations. This document may be downloaded at the following website: enter web page address.
Alternative Formats:
[bookmark: Text35]GUIDANCE: Update the following to reflect what alternative formats will be made available and update contact information as needed. For individuals with sensory disabilities, this document can be made available in Braille, in large print, on audiocassette, or on computer disk. To obtain a copy in one of these alternate formats, please call or write to enter Caltrans or (Local Agency), Attn: Enter contact name and address; enter phone number (Voice), or use the California Relay Service 1 (800) 735-2929 (TTY to Voice), 1 (800) 735-2922 (Voice to TTY), 1 (800) 855-3000 (Spanish TTY to Voice and Voice to TTY), 1-800-854-7784 (Spanish and English Speech-to-Speech) or 711.


TITLE SHEET GUIDANCE:
· Modify the text on this page as appropriate for the project.
· Add an agency signature block only if the agency is involved as a joint lead agency under NEPA.
[bookmark: Text66][bookmark: Text62]FHWA Highway ID No. enter # if applicable	SCH# Enter SCH number
[bookmark: Text63]Enter district-county-route-postmiles
Enter EA/EFIS
Enter Federal Aid Number for Local Assistance projects
[bookmark: Text17]Enter short descriptive phrase consistent with project alternative(s) such as “widen” or “improve” or “rehabilitate” and general description of project location
[bookmark: _Hlk61530324][bookmark: _Hlk61530833]Environmental Assessment and enter Draft or Final Section 4(f) Evaluation [NOTE: only include if there is an Individual or Programmatic Section 4(f) Evaluation] with Finding of No Significant Impact [NOTE: only add for “Final” EA]
Submitted Pursuant to: (Federal) 42 USC 4332(2)(C)
[NOTE: If there is an Individual or Programmatic Section 4(f) Evaluation, add: 49 USC 303, and/or 23 USC 138]
THE STATE OF CALIFORNIA
Department of Transportation
and
[bookmark: Text18]enter (Local Agency) if appropriate

[bookmark: Text19]Cooperating Agencies: enter cooperating agencies
[bookmark: _Hlk122629211]____________________________	_______________
Enter name	Date
District Director
California Department of Transportation
NEPA Lead Agency
The following persons may be contacted for more information about this document:
Enter name, address, telephone, and email information for Caltrans and local agency contacts.
[bookmark: _Toc117166477][bookmark: _Toc126070449]
Finding of No Significant Impact (FONSI)
GUIDANCE: This is for the “final” EA. The FONSI is prepared by Caltrans. Do not include a blank FONSI in a “draft” EA See the Forms and Templates page of the Standard Environmental Reference (SER) for a sample FONSI.


[bookmark: _Toc117166480][bookmark: _Toc126070450]Summary
GUIDANCE: The summary is optional for an EA. If a summary is included, follow the guidance provided in the AO. The headers and table below may be edited/deleted as appropriate for the project.
[bookmark: Text61]Begin typing here
NEPA ASSIGNMENT
GUIDANCE: Insert boilerplate text from AO.
Begin typing here
PROJECT OVERVIEW
Begin typing here
Lead Agencies and NEPA/CEQA Documentation
GUIDANCE: Insert boilerplate text from AO.
Begin typing here
Project Area
Begin typing here
Purpose and Need
Begin typing here
Proposed Action
Begin typing here
PROJECT IMPACTS
Begin typing here
GUIDANCE: A table can be used to summarize impacts. Edit resource topics appropriately.
Summary Table 1: Summary of Major Potential Impacts from Alternatives
	Potential Impact
	Alternative Enter alt name
	Alternative Enter alt name
	Alternative Enter alt name
	No-Build Alternative

	Consistency with State, Regional, and Local Plans and Programs
	
	
	
	

	Coastal Zone
	
	
	
	

	Wild and Scenic Rivers
	
	
	
	

	Parks and Recreational Facilities
	
	
	
	

	Farmland and Timberland
	
	
	
	

	Growth
	
	
	
	

	Community Character and Cohesion
	
	
	
	

	Relocations and Real Property Acquisition
	
	
	
	

	Environmental Justice
	
	
	
	

	Equity
	
	
	
	

	Utilities and Emergency Services
	
	
	
	

	Traffic and Transportation/ Pedestrian and Bicycle Facilities
	
	
	
	

	Visual/Aesthetics
	
	
	
	

	Cultural Resources
	
	
	
	

	Hydrology and Floodplain
	
	
	
	

	Water Quality and Storm Water Runoff
	
	
	
	

	Geology, Soils, Seismicity and Topography
	
	
	
	

	Paleontology
	
	
	
	

	Hazardous Waste and Materials
	
	
	
	

	Air Quality
	
	
	
	

	Noise and Vibration
	
	
	
	

	Natural Communities
	
	
	
	

	Wetlands and Other Waters
	
	
	
	

	Plant Species
	
	
	
	

	Animal Species
	
	
	
	

	Threatened and Endangered Species
	
	
	
	

	Invasive Species
	
	
	
	

	Construction
	
	
	
	

	Cumulative Impacts
	
	
	
	



COORDINATION WITH PUBLIC AND OTHER AGENCIES
Begin typing here



[bookmark: _Toc117166481][bookmark: _Toc126070451]Table of Contents
[bookmark: _Hlk109047808]GUIDANCE: To update the table of contents (TOC), hover cursor over table and right click. Choose update field and update entire table. For topics not needed, or to modify a header, delete or edit the header in the body of the document and then update the TOC.
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[bookmark: _Toc117166482][bookmark: _Toc126070452]List of Tables
[bookmark: _Hlk89333111]GUIDANCE: Include a list of tables here. Make sure to update whenever edits are made to table numbers and before finalizing document. To update, right click on entry below and choose “Update Field” and update entire table.
Table 1‑1: Permits and Approvals	3
Table 2‑1: Resource Topics Dismissed from Analysis	4

[bookmark: _Toc117166483][bookmark: _Toc126070453]List of Figures
[bookmark: _Hlk109047889]GUIDANCE: Include a list of figures here. Make sure to update whenever edits are made to figure numbers and before finalizing document. To update, right click on entry below and choose “Update Field” and update entire table.
To aid the public in locating maps, it is recommended to clearly show where mapping can be found, particularly for the preferred alternative (if it has been identified).
No table of figures entries found.


[Insert document name] 14
[bookmark: _Toc117166484][bookmark: _Toc126070454]Proposed Project
[bookmark: _Toc117166485]GUIDANCE: Edit the headers below as appropriate for the project. Delete unused headers.
[bookmark: _Toc126070455]INTRODUCTION
Begin typing here
[bookmark: _Toc117166486][bookmark: _Toc126070456]PURPOSE AND NEED
[bookmark: Text57]Begin typing here
[bookmark: _Toc117166487][bookmark: _Toc126070457]Purpose
Begin typing here
[bookmark: _Toc117166488][bookmark: _Toc126070458]Need
Begin typing here
[bookmark: _Toc117166489][bookmark: _Toc126070459]Independent Utility and Logical Termini
Begin typing here
[bookmark: _Toc117166490][bookmark: _Toc126070460]PROJECT DESCRIPTION
Begin typing here
[bookmark: _Toc117166491][bookmark: _Toc126070461]PROJECT ALTERNATIVES
GUIDANCE: Edit alternative names as appropriate. To add additional alternatives, type in the header (alternative) name, highlight header, and choose “Heading 3” located under “Styles" in the “Home” tab of the Ribbon.
Begin typing here
[bookmark: _Toc117166492][bookmark: _Toc126070462]No-Build (No-Action) Alternative
Begin typing here
[bookmark: _Toc117166493][bookmark: _Toc126070463]Alternative 1
Begin typing here
[bookmark: _Toc117166494][bookmark: _Toc126070464]Alternative 2
Begin typing here
[bookmark: _Toc117166495][bookmark: _Toc126070465]Common Design Features of the Build Alternatives
GUIDANCE: This section is optional, delete if not used.
Begin typing here
[bookmark: _Toc117166496][bookmark: _Toc126070466]Unique Features of Build Alternatives
GUIDANCE: This section is optional, delete if not used.
Begin typing here
[bookmark: _Toc117166497][bookmark: _Toc126070467]Transportation System Management (TSM) and Transportation Demand Management (TDM) Alternatives
GUIDANCE: Include only if applicable.
Begin typing here
[bookmark: _Toc117166498][bookmark: _Toc126070468]Reversible Lanes
GUIDANCE: Include only if applicable.
Begin typing here
[bookmark: _Toc117166499][bookmark: _Toc126070469]Access to Navigable Rivers
GUIDANCE: Include only if applicable.
Begin typing here
[bookmark: _Toc117166500][bookmark: _Toc126070470]COMPARISON OF ALTERNATIVES
Begin typing here
[bookmark: _Toc117166501][bookmark: _Toc126070471]IDENTIFICATION OF A PREFERRED ALTERNATIVE
GUIDANCE: This would be in the final document.
Begin typing here
[bookmark: _Toc117166502][bookmark: _Toc126070472]ALTERNATIVES CONSIDERED BUT ELIMINATED FROM FURTHER DISCUSSION
GUIDANCE: For final document, change section title to: ALTERNATIVES CONSIDERED BUT ELIMINATED FROM FURTHER DISCUSSION PRIOR TO “DRAFT” ENVIRONMENTAL ASSESSMENT.
[bookmark: _Toc117166503][bookmark: _Toc126070473]Alternative 1
Begin typing here
[bookmark: _Toc117166504][bookmark: _Toc126070474]Alternative 2
Begin typing here
[bookmark: _Toc117166505][bookmark: _Toc126070475]PERMITS AND APPROVALS NEEDED
The following permits, licenses, agreements, and certifications (PLACs) are required for project construction:
[bookmark: _Toc117166599]Table 1‑1: Permits and Approvals
	Agency
	PLAC
	Status

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	




[bookmark: _Toc117166506][bookmark: _Toc126070476]Affected Environment, Environmental Consequences, and Avoidance, Minimization, and/or Mitigation Measures
[bookmark: _Toc117166507][bookmark: _Toc126070477]TOPICS CONSIDERED BUT DETERMINED NOT TO BE RELEVANT
[bookmark: _Hlk61542232]As part of the scoping and environmental analysis carried out for the project, the following environmental issues were considered but no adverse impacts were identified. As a result, there is no further discussion about these issues in this document.
GUIDANCE: To add additional resource topics, type in the header name, highlight header, and choose “Heading 3” located under “Styles" in the “Home” tab of the Ribbon. Please refer to the AO for guidance and any required boilerplate language, particularly for Environmental Justice, NOAA species list, and Section 4(f).
[bookmark: _Toc117166508][bookmark: _Toc126070478]Resource Topic 1
Begin typing here
[bookmark: _Toc117166509][bookmark: _Toc126070479]Resource Topic 2
Begin typing here
GUIDANCE: The information above may also be presented in a table format as shown below.
[bookmark: _Toc117166600]Table 2‑1: Resource Topics Dismissed from Analysis
	Resource
	Rationale for Dismissal

	
	

	
	

	
	

	
	

	
	

	
	

	
	





[bookmark: _Toc117166510][bookmark: _Toc126070480]HUMAN ENVIRONMENT
GUIDANCE: Remove headings and sub-headers as needed for your project.
[bookmark: _Toc117166511][bookmark: _Toc126070481]Existing and Future Land Use
GUIDANCE: This section should be used as an introduction for the context and environmental setting for the project and can be cross referenced in the sections below as appropriate.
Begin typing here
[bookmark: _Toc117166512][bookmark: _Toc126070482]Consistency with State, Regional, and Local Plans and Programs
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166513][bookmark: _Toc126070483]Coastal Zone
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166514][bookmark: _Toc126070484]Wild and Scenic Rivers
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166515][bookmark: _Toc126070485]Parks and Recreational Facilities
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166516][bookmark: _Toc126070486]Farmlands
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166517][bookmark: _Toc126070487]Timberlands
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166518][bookmark: _Toc126070488]Growth
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166519][bookmark: _Toc126070489]Community Character and Cohesion
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166520][bookmark: _Toc126070490]Relocations and Real Property Acquisition
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166521][bookmark: _Toc126070491]Environmental Justice
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166522][bookmark: _Toc126070492]Equity
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166523][bookmark: _Toc126070493]Utilities/Emergency Services
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166524][bookmark: _Toc126070494]Traffic and Transportation/Pedestrian and Bicycle Facilities
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166525][bookmark: _Toc126070495]Visual/Aesthetics
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166526][bookmark: _Toc126070496]Cultural Resources
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166527][bookmark: _Toc126070497]PHYSICAL ENVIRONMENT
[bookmark: _Toc117166528][bookmark: _Toc126070498]Hydrology and Floodplain
[bookmark: _Ref69219344]Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
Only Practicable Alternative Finding
GUIDANCE: This section is required in the final document only when there is a significant encroachment into the base or 100-year floodplain.
Begin typing here
[bookmark: _Toc117166529][bookmark: _Toc126070499]Water Quality and Stormwater Runoff
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166530][bookmark: _Toc126070500]Geology/Soils/Seismic/Topography
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166531][bookmark: _Toc126070501]Paleontology
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166532][bookmark: _Toc126070502]Hazardous Waste/Materials
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166533][bookmark: _Toc126070503]Air Quality
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166534][bookmark: _Toc126070504][bookmark: Text58]Noise enter and Vibration if applicable
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Abatement Measures
Begin typing here
[bookmark: _Toc117166536][bookmark: _Toc126070505]BIOLOGICAL ENVIRONMENT
[bookmark: _Toc117166537][bookmark: _Toc126070506]Natural Communities
[bookmark: _Ref69219420]Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166538][bookmark: _Toc126070507]Wetlands and Other Waters
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
Wetlands Only Practicable Alternative Finding
GUIDANCE: For the final document, include this subheading if the preferred alternative will permanently impact wetlands.
Begin typing here
[bookmark: _Toc117166539][bookmark: _Toc126070508]Plant Species
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166540][bookmark: _Toc126070509]Animal Species
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166541][bookmark: _Toc126070510]Threatened and Endangered Species
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166542][bookmark: _Toc126070511]Invasive Species
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166543][bookmark: _Toc126070512]CONSTRUCTION IMPACTS
GUIDANCE: This is an optional placement for construction impacts. If construction impacts have not been discussed above and/or the project is likely to have many construction impacts, consider adding a separate Construction Impacts section.
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here
[bookmark: _Toc117166544][bookmark: _Toc126070513]CUMULATIVE IMPACTS
GUIDANCE: This is an optional placement for cumulative impacts. If cumulative impacts have not been discussed under each resource section above, discuss them here.
Regulatory Setting
Begin typing here
Affected Environment
Begin typing here
Environmental Consequences
Begin typing here
Avoidance, Minimization, and/or Mitigation Measures
Begin typing here


[bookmark: _Toc117166572][bookmark: _Toc126070514]Comments and Coordination
[bookmark: Text60]Begin typing here


[bookmark: _Toc117166573][bookmark: _Toc126070515]List of Preparers
Begin typing here


[bookmark: _Toc117166574][bookmark: _Toc126070516]Distribution List
Begin typing here


[bookmark: _Toc117166575][bookmark: _Toc126070517]Section 4(f)
GUIDANCE: Only use the sections below which apply to your project.
[bookmark: _Ref69231167][bookmark: _Toc117166576][bookmark: _Toc126070518]INDIVIDUAL SECTION 4(F) EVALUATION
Begin typing here
[bookmark: _Toc117166577][bookmark: _Toc126070519]Introduction
Begin typing here
[bookmark: _Toc117166578][bookmark: _Toc126070520]Description of the Proposed Project
Begin typing here
[bookmark: _Toc117166579][bookmark: _Toc126070521]Section 4(f) Properties
Begin typing here
[bookmark: _Toc117166580][bookmark: _Toc126070522]Use of the Section 4(f) Property
Begin typing here
[bookmark: _Toc117166581][bookmark: _Toc126070523]Avoidance Alternatives
Begin typing here
[bookmark: _Toc117166582][bookmark: _Toc126070524]Measures to Minimize Harm to the Section 4(f) Property
Begin typing here
[bookmark: _Toc117166583][bookmark: _Toc126070525]Least Harm Analysis and Concluding Statement
[bookmark: _Hlk66273613]NOTE: This section is included in the final document.
Begin typing here
[bookmark: _Toc117166584][bookmark: _Toc126070526]Coordination
Begin typing here
[bookmark: _Toc117166585][bookmark: _Toc126070527]PROGRAMMATIC SECTION 4(F) DETERMINATION(S)
Begin typing here
[bookmark: _Toc117166586][bookmark: _Toc126070528]SECTION 4(F) DE MINIMIS DETERMINATION(S)
Begin typing here
[bookmark: _Toc117166587][bookmark: _Toc126070529]RESOURCES EVALUATED RELATIVE TO THE REQUIREMENTS OF SECTION 4(F): NO-USE DETERMINATION(S)
Begin typing here
[bookmark: _Toc117166588][bookmark: _Toc126070530]SECTION 6(F)
Begin typing here


[bookmark: _Toc117166589][bookmark: _Toc126070531]Title VI/Non-Discrimination Policy Statement
[bookmark: _Hlk66281039]GUIDANCE: Insert the most recent Title VI/Non-Discrimination Policy Statement here. The most recent version can be found on the Caltrans Civil Rights Title VI page.
Insert policy here


[bookmark: _Toc117166590][bookmark: _Toc126070532]Summary of Relocation Benefits
[bookmark: _Toc117166591]GUIDANCE: Include this appendix if the proposed project involves any relocations.
[bookmark: _Toc126070533]CALIFORNIA DEPARTMENT OF TRANSPORTATION RELOCATION ASSISTANCE PROGRAM
Begin typing here


[bookmark: _Toc117166592][bookmark: _Toc126070534]Avoidance, Minimization and/or Mitigation Summary
Begin typing here


[bookmark: _Toc117166593][bookmark: _Toc126070535]Required Consultation/ Concurrence Documentation
GUIDANCE: This appendix is for the final document only.
Begin typing here


[bookmark: _Toc117166594][bookmark: _Toc126070536]Comment Letters and Responses
GUIDANCE: This appendix is for the final document and should be used if comment letters and response are not included in the Comments and Coordination Chapter.
Begin typing here


[bookmark: _Toc117166595][bookmark: _Toc126070537]Final Determination of Engineering and Operational Acceptability
GUIDANCE: Include this appendix in the final document if applicable (i.e., the project includes Federal Highway approval of access modification). For additional information, see the “Updates on FHWA’s ‘Policy on Access to the Interstate System’” letter located on the SER Policy Memo page.
Begin typing here


[bookmark: _Toc117166596][bookmark: _Toc126070538]List of Technical Studies
The following studies and/or technical analyses have been prepared and are incorporated by reference into this Environmental Assessment and can be located at: 
[bookmark: Text69]Enter location where technical studies may be accessed.
GUIDANCE: Include the following information with the cultural study reference:
Please note, many state and federal laws limit the disclosure of sensitive cultural and tribal resource information to the public. Additional information regarding confidentiality of these resources can be found in the Standard Environmental Reference Volume 2 in Section 3.4.13 and Section 5.3.6.



[bookmark: _Toc117166597][bookmark: _Toc126070539]Glossary of Technical Terms
GUIDANCE: This appendix is optional.
Begin typing here


[bookmark: _Toc117166598][bookmark: _Toc126070540]List of Acronyms and Abbreviations
GUIDANCE: This appendix is optional.
Begin typing here
[Insert document name] 2
image1.jpeg




